Dear Friends,

Almost every day we speak with another family member, friend, or colleague who for the first time is reflecting on a deep question — are we living through the end of American democracy?

While our nation has weathered trying times before, the multitude of events in recent years - from the polarized response to COVID-19, to societal tensions over race, to the seeming politicization and of nearly every facet of our lives and culture — has become overbearing.

Given this moment of collective reflection, we thought it appropriate to do our own introspection at FixUS. What follows is a progress report that takes stock of our experiences and accomplishments to date, while also laying out the approach we’ve taken, what we’ve learned, and what it means for us going forward into our next phase.

In doing so, it’s worth starting with the answer to a question we often get from people new to FixUS: “So why has the Committee for a Responsible Federal Budget gotten involved in efforts to deal with political polarization?”

The Committee has and will continue to be focused on advancing fiscal responsibility at the federal level. Yet over time it became clear the necessary conditions for addressing our fiscal challenges do not exist. We are living through a political climate that prioritizes politics over policy, the short-term over the long-term, and winning at all costs over compromise. This led us to ask some critical questions about the state of our politics: How did things get this bad? Why are we so divided? How deep does this division run? And what can we do about it?

As we conducted initial research into these topics, we were alarmed by what we found. America is plagued by significant levels of internal division, governmental dysfunction, and public distrust. Many Americans believe that our country is headed towards a second civil war. Clearly the paralysis surrounding the budget challenge was only the tip of the iceberg, with the health of our society rapidly deteriorating by several metrics.

The Committee decided to launch FixUS as a distinct project, outside the Committee’s core work, because we believed the division and dysfunction in our politics affects not only our core interest of addressing the debt, but due to the threat it poses to the viability of our democracy itself. We did so with the humility of not knowing what has to
be done to fix it, but with a desire to play whatever role we could in helping build a community of those willing to work with us to help figure out and support solutions over time.

The following report will walk you through the process we have taken during this first phase of our work, all of which is grounded in two simple principles that underlie our approach and are embedded within the name FixUS.

First principle is that America faces many challenges and threats, but sustainable solutions will remain elusive until the country comes together to fix the underlying root causes of our division, distrust, and dysfunction in our democracy. These root causes are political, cultural, economic, and technological in nature, and we embrace this complexity and the need to better understand it so as to be able to ultimately advance a holistic strategy to fix what ails our country.

The second principle is that ultimately the fix is us—with meaningful change resting in how each of us engages as individuals and within our circles of influence to help create a better future. Engagement cannot be an “inside the beltway” exercise. Meaningful engagement must reach the underrepresented segments of the general public often disconnected from the policymaking process, and bridge the divide between institutional leaders and everyday citizens. Potential solutions abound in the halls of academia, among elected officials, and in other elite institutions, but for any of these to be effective they require buy-in from everyday people.

At the conclusion of the report we outline where we plan to take FixUS next. Admittedly, the enormity and weight of the moment sometimes makes us question what we could possibly do to meaningfully address these challenges, as opposed to feeling like we are re-arranging the deck chairs on our sinking ship of state.

But history shows in America it is often darkest before the dawn, and we are heartened by the best lesson we learned since starting FixUS: We are far from alone. FixUS is part of a burgeoning field of reformers and advocates that is still taking shape, and who are beginning to work together over what will be the multi-decade task of saving the American experiment.

We are proud of our achievements to date, and deeply appreciative of all those supporters who have come along with us on this journey. Our work has only begun, and in spite of the enormity of the challenge it’s a cause we will go down fighting for.

Sincerely,

Maya MacGuineas
Founder, FixUS

Michael V. Murphy
Director, FixUS

---

Each step during the first phase of FixUS was grounded in a process of both learning and engaging. We’ve deliberately taken the approach of trying to deeply understand how it is we’ve gotten to this troubled point in the first place, while beginning to build a network of necessary audiences—including societal leaders, political reform groups, and most importantly the general public—whose perspectives and engagement is necessary to inform a path forward.

Reaching the first of these audiences required hitting the road, where over nearly two years we met with over 70 audiences in 23 states. During these events our team had the chance to meet with a diverse array of Americans who were united in their shared concern over the state of our country. The FixUS Roadshow and Listening Tour held presentations for large and small audiences, fostered group discussions, and challenged participants to consider what has gone wrong and what can be done.

“Our democracy is not going to work unless both sides are willing to deal with each other.”

Leon Panetta, Secretary of Defense

Fort Smith, AR*
Phoenix, AZ
Tempe, AZ
Palo Alto, CA
Denver, CO*
Washington, DC*
Newark, DE*
Boca Raton, FL
Coral Gables, FL*
Naples, FL*
Orlando, FL
St. Augustine, FL*
Atlanta, GA*
Athens, GA* Chicago, IL
Muncie, IN
South Bend, IN
Shreveport, LA
Boston, MA
Greenbelt, MD
Rockville, MD
Baltimore, MD
Edina, MN*
Eagan, MN
Minneapolis, MN
Plymouth, MN
Charlotte, NC*

Gastonia, NC
Pinehurst, NC
Raleigh, NC
Omaha, NE*
Albany, NY
Bolton Landing, NY
Cleveland, OH
Warren, OH
Wooster, OH
Youngstown, OH
Tulsa, OK
Erie, PA
Phoenixville, PA
Greenville, SC
Austin, TX*
Grandbury, TX
Houston, TX*
Salt Lake City, UT
Arlington, VA
Chantilly, VA
Fairfax, VA
Pella, IA
Middleburg, VA
Springfield, VA
Madison, WI
Waukesha, WI
Shepherdstown, WV

*Location has been visited two or more times.
America’s Response

“I fear for the future of my children and grandchildren and that they will see the current political system is somewhat ‘normal’ over time. I don’t want my grandchildren to be saddled with all of our debt.”

Carol Smith, Waukesha, WI

“I hope that events like ours today continue to open the eyes of the younger generation since we are the upcoming leaders of our country.”

Sophomore Garrett Spain in the Southwest Times Record after participating in event at the University of Arkansas, Fort Smith

“It’s important to have open national dialogues on possible changes that could make our democracy more fair, work more effectively and inclusively and learn about our civic responsibilities.”

Marge Carnahan, Galion, OH

Lessons from the Road on How to Heal our Fractured Country

1. Americans are frustrated and exhausted with the political battle in Washington and as a result, are tuning it out.

2. The drivers of our divide are deep and wide ranging across multiple cultural, economic, and political factors.

3. Americans feel a growing sense of being disconnected and are distrustful of institutions, experts, and elites.

4. There is a vast community of Americans that feels politically homeless, yet they express hope after experiencing an alternative to our divided state of affairs.

5. While there is little agreement about specific solutions to our divide, most Americans are willing to work together and are eager to keep the conversation going... and so we will.
After the roadshow, we were left with in many ways a contradictory conclusion. On the one hand, America and our political system was indeed very polarized and deeply divided, and it was necessary to dig deeper to understand why. At the same time we sensed that at the individual level, Americans may not be as divided as the national narratives suggest.

To test this question, in October 2020 FixUS conducted a poll, in partnership with Ipsos, and launched of our National Dialogue on Common Values, Goals, and Aspirations, which sought to generate discussion, engagement, and feedback surrounding areas of commonality and key differences among Americans. We hosted over a dozen virtual focus groups during which we presented the poll’s findings, fostered discussions, and captured participants’ impressions.

Cross-partisan consensus still remains on several key issues.

### THERE IS A BIPARTISAN AGREEMENT REGARDING THE IMPORTANCE OF CERTAIN VALUES IN DEFINING AMERICA AS A NATION

*How important are the following values in defining America as a nation?*

<table>
<thead>
<tr>
<th>Value</th>
<th>81%</th>
<th>83%</th>
<th>83%</th>
<th>80%</th>
<th>83%</th>
<th>80%</th>
<th>80%</th>
<th>81%</th>
<th>82%</th>
<th>76%</th>
<th>79%</th>
<th>77%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Speech</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equal Justice Under Law</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ensuring Everyone has an Opportunity to Succeed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Working Together Toward the Common Good</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The results of the project were summarized in our report, *Divided Nationally, United Locally*, which found that despite our country’s deep political divisions on highly nationalized issues, Americans share certain core values and aspirations for themselves, their families, and their communities. At the same time they pointed to questions surrounding perceived divides over certain values that require a deeper level of understanding.

**Divided Nationally, United Locally**

1. We have much more in common with regard to individual and community values than national narratives suggest.
2. Safety can be a basic need, but could also mean protection from others.
3. Patriotism has become a divisive and loaded term.
4. “Being Honest” is a core value held by nearly all Americans, but its support surprised participants and requires deeper understanding.
5. Americans are interested in different possible “Moonshot” ideas to help bridge our divides.

“What struck me straight away was there was hardly any difference between Republicans and Democrats [when it comes to individual goals and values]… I began to ask myself, ‘Why do we talk so much about not being united?’”

P.K. (TX)

“It was very promising that, you know, hopefully, we do have an opportunity moving forward here that we can find common ground and kind of get back to listening to one another.”

Sharon (WI)

“We actually agree on most of our core values. We just disagree on how well we’re doing and addressing those values and what we should do, like the mechanisms by which we could address those values and, which it seems to me, has always been the divide.”

Jessica (MA)

“We’re all pretty much the same. We see this. We see that we want a lot of the same things. It’s just that our lenses are slightly different. And sometimes…we process through our lenses and we pull in different information and process it differently.”

Lynnae (CO)

Americans still agree on the importance of several core values.

**THERE IS A BIPARTISAN AGREEMENT REGARDING THE IMPORTANCE OF CERTAIN VALUES IN DEFINING AMERICA AS A NATION**

How important are the following values in defining America as a nation?

- **Being Hard Working**: 97%
  - Republicans: 98%
  - Democrats: 97%
- **Being Honest**: 97%
  - Republicans: 97%
  - Democrats: 99%
- **Being Independent**: 96%
  - Republicans: 96%
  - Democrats: 97%
- **Being Well Educated**: 95%
  - Republicans: 95%
  - Democrats: 97%
- **Being Generous**: 93%
  - Republicans: 92%
  - Democrats: 96%
- **Being Well Respected**: 93%
  - Republicans: 94%
  - Democrats: 96%
- **Being Connected to Other People**: 88%
  - Republicans: 92%
  - Democrats: 90%
- **Being Patriotic**: 82%
  - Republicans: 95%
  - Democrats: 74%
- **Being Committed to a Religion/Faith**: 65%
  - Republicans: 81%
  - Democrats: 55%
- **Being Wealthy**: 60%
  - Republicans: 62%
  - Democrats: 62%
In early 2021, FixUS released a report, *Why is Governing No Longer Good Politics? Reflections from a Thousand Years of Public Service.* The report was inspired by former Secretary of Defense Leon Panetta, who posed to us a simple question with no clear answer: “Why is governing no longer good politics?”

This straightforward question encapsulates why so many Americans feel politically homeless, and frustrated with their government. Why after years of campaigning and elections, and billions of dollars spent trying to convince voters of the right path forward for the country, does nothing seem to change? Moreover, why does partisanship continue to drag down our political process, and what, if anything, can be done to stop this dysfunction?

The report canvassed the opinions of dozens of former elected and appointed officials, who further amplified this message in the media throughout 2021.

**Boston Herald**

“Politics has an important role in our country, but it is not the highest duty we have as citizens or as public servants. Not everything has to be reduced to how it can best fit party-line narratives.”

David Shulkin
Secretary of Veterans Affairs

**PennLive Patriot-News**

“For those of us who have served in elected office, the question is: how do we fix this situation? How do we restore trust in our elections and renew confidence that, once elected, our leaders will fight for what they believe in, while also seeking the common ground necessary to serve and maintain a nation?”

Allyson Schwartz
United States Representative

**Roll Call**

“Over the past few decades, an alternative political playbook has emerged. The new playbook short-circuits the role of consensus building in American politics and replaces it with partisanship, power politics and, at times, outright hostility toward the opposition.”

Mack McLarty
White House Chief of Staff
Why is Governing No Longer Good Politics?
Reflections from a Thousand Years of Public Service

1. Gerrymandered congressional districts, partisan primaries, and money in politics were consistently cited as core contributors to our current environment, and were offered as necessary areas for reform if we are to improve governance in the future.

2. The shifting media landscape has made it harder for officials to agree on a shared set of facts, with legislators and voters able to seek out media sources and narratives that reinforce their own opinions and theories.

3. Those in office must serve with character, get to know their fellow officials, find agreement on a common set of facts, compromise, exercise judgement and a strong work ethic, and above all else practice civility towards each other.

4. Governing can be good politics, but only if we the people champion those who make it so and get engaged in doing the hard work of creating a better future.

“The dysfunction in Washington has gone on for too long and will not be easy to change. But change can happen if both parties discover again that governing can be good politics.”
Leon Panetta, Secretary of Defense

“Limited characters on social media and limited attention spans make this problem acute and it extends from citizens to those that govern.”
Sylvia Burwell, Secretary of Health and Human Services

“But there is hope, and it lies in the optimistic, innovative, and courageous American people who have witnessed the best and worst examples of leadership in their recent lifetimes.”
Margaret Spellings, Secretary of Education

“I believe good governing leads to good politics. As we see too often today, politics doesn’t lead to good governing.”
John Kasich, Governor of Ohio
Having engaged everyday Americans and former government officials on the challenges facing our democracy, we also sought out the perspectives of those that have studied the challenges of polarization and mounting distrust for years.

In March 2021, we convened 30 leading academics from several fields of scholarship for a half-day virtual conference, during which participants shared their thoughts on the current state of our politics and explored the connections between different scholarly approaches to studying the subject.

After the event's conclusion, we felt that the participants' commentary provided us with numerous new avenues of inquiry. We published a report based to help spur conversation, titled Root Causes Perspectives: How Did We Get Here? The report contains a series of macro-level questions about the state of contemporary American politics and civil society.

FixUS has also hosted dozens of in-person and virtual forums to explore the nature of the challenges facing our democracy featuring leading intellectuals and experts. We also formed 10 local chapters of FixUS in Alaska, Arizona, California, Colorado, Indiana, Illinois, Michigan, Minnesota, North Carolina, and Virginia, each of which hosted events in their states and communities.

**America’s Response**

Roundtable quotes below are excerpts.

“And so that’s part of what we’re trying to do here, that FixUS is trying to do, is convene the best neurons to put together to make the best brain that can figure out what the hell is happening to us and what we should do to improve this complex dynamical system in which most of us are affected by our motivated reasoning and our partisan commitments.”

Jonathan Haidt, New York University

“We’ve shifted from a politics that was defined by a left and right that split on economic ideology in the 20th century to one more defined by cultural identity issues, and that is something that is not good for democratic politics because those cultural attachments are much more fixed and harder to negotiate...”

Francis Fukuyama, Stanford University

“The story of America is the expansion of freedom. We know that story and we have benefited from it, but our political culture continues to divide, to choke progress, and attack our binding civic ethos.”

Melody Barnes, University of Virginia

“We talked about the importance of disagreeing constructively. If that’s a critical element, I think social media is the antagonist to that possibility. Twitter and Facebook are not designed for constructive disagreement.”

Tristan Harris, Center for Humane Technology
We realized early on that FixUS was only one of hundreds of initiatives—some long lasting and many newly formed—that make up a broader ecosystem of organizations committed to addressing the challenges of our current moment. While many believe this ecosystem requires some consolidation to better coordinate, we recognized a need to help connect this ecosystem—to learn what others are up to as a way of spurring potential collaborations. We also saw a desire for people who are new to this budding field to have a place where they can find out what is going on and get plugged in.

Central to this approach has been our bimonthly Democracy Reformers Breakfast Group, which has grown to include over 289 leaders of reform organizations, experts, along with other leaders in public policy and advocacy who are less traditionally focused on democracy reform. The group shares updates, builds connections, and has generated numerous collaborations among participants. We also partnered with many organization on different initiatives, including America Talks, which facilitated a weekend event where thousands of participants were matched in face to face, one on one conversations across political divides.

**STEP 5: BUILD A NETWORK TO CONNECT AND COLLABORATE**
FixUS has collaborated with over 170 organizations

» ActiVote
» Alliance for Health Policy
» Alliance for Market Solutions
» Alliance for Peacebuilding
» AllSides
» American Academy of Arts and Sciences
» American Awakening
» American Enterprise Institute
» American Exchange Project
» American Heart Association
» American Immigration Council
» American Promise
» Aspen Institute
» Big Tent Nation
» BIPAC
» Bipartisan Policy Center
» Brookings Institution
» Braver Angels
» Bridge Alliance
» BridgeUSA
» Bridging Divides Initiative
» Business for America
» Campaign for an Informed Citizenry
» Campaign for Tobacco-Free Kids
» Campaign Legal Center
» Center for Election Innovation & Research
» Center for Inclusion and Belonging
» Center for the Study of the Presidency & Congress (CSPC)
» Center on Democracy, Development, and the Rule of Law (CDDRL) at Stanford University
» Change the Rules
» Citizen Data
» Civic Genius
» Civic Health Project
» Civil Dialogues
» Common Ground Committee
» Congressional Management Foundation
» Consensus Building Institute
» Convergence Center for Policy Resolution
» Democracy Fund
» Democracy Reform Ranking Project
» ecoAmerica
» Electoral Innovation Lab
» Fairmandering
» FairVote
» Faith and Politics Institute
» Fighting To Understand
» Freedom House
» Generation Citizen
» Henry Clay Center
» Hewlett Foundation
» iCivics
» Independent Americans United
» Independent Voter Project
» Independent Voting
» Institute for Political Innovation
» Invest America Fund
» Ipsos
» Issue One
» Jefferson Center
» Leadership Now Project
» Level the Playing Field
» Listen First Project
» Living Room Conversations
» Lodestar Foundation
» Lubetzky Family Foundation
» Make Integrity Great Again
» More in Common
» National Alliance for Public Charter Schools
» National Association of Nonpartisan Reformers
» National Breast Cancer Coalition
» National Coalition on Health Care
» National Conference on Citizenship
» National Consumers League
» National Institute for Civil Discourse
» National Institute on Money in State Politics
» National Small Business Association
» Niskanen Center
» One America Movement
» One Virginia 2021
» Open Primaries
» OpenMind
» Partnership for American Democracy
» Partnership for Public Service
» Project on Ethics in Political Communication - The George Washington University
» Project On Government Oversight
» Protect Democracy
» Public Agenda
» R Street Institute
» Renew Democracy Initiative
» Rebuild Congress Initiative
» Represent.us
» Resetting the Table
» Serve America Movement (SAM)
» Service Year Alliance
» SNF Agora Institute - Johns Hopkins University
» Stand Up Republic Institute
» Support the Center
» The American Leader
» The Concord Coalition
» The Democracy Group
» The Fulcrum
» The Lugar Center
» The People
» The Village Square
» Third Way
» Transparency International
» U.S. PIRG
» UNITE
» Unite America
» USC Dornsife Center for the Political Future
» USAFacts
» Vanderbilt Project on Unity and American Democracy
» Verified Voting
» Voice of the People
» Walton Family Foundation
» Welcoming America
» YOUnify
NEXT PHASE
OF FIXUS

Where do we go from here? In the months and years ahead, FixUS will be building on its early phase of work by honing in on three core pillars of our strategy:

**Space for Thinking, Connecting, and Doing.** A key takeaway from our experience to date is that no matter how much you think you understand the nature of the problem we face, you don’t. Events are happening so rapidly and unexpectedly that a continuous and ongoing analysis of the challenges facing our democracy is required. At the same time, meaningful change will be a long-term effort, and requires balancing that reality with the need to channel the urgency of the moment to bite off small wins and make ongoing adjustments. Because the work of studying the problem and action-oriented reform are often siloed, going forward we will expand our democracy reformers group to build a more sustained, coordinated, and connected network, and direct participants to the most promising off-ramps for action.

**Unum Test for our Democracy.** In April 2021, several key leaders in the FixUS effort penned an op-ed in TIME calling for “The Unum Test.” The goal is to focus attention on identifying and advancing policies that have the explicit purpose of uniting our country over the long term. Over the next phase of FixUS, we will be using the Unum Test framework to engage Americans on what values and policies meet the Unum Test.

**Shared Patriotism.** Patriotism can act as a unifying force to help our country achieve lofty goals like putting a man on the moon or healing in the aftermath of national tragedy. Yet over the past few decades we have seen divides over patriotism at the center of our culture wars, to the point where symbols like the American flag have become divisive partisan cues. This finding was backed up in our research and engagement. In our next phase FixUS is launching a research and engagement effort on the issue to explore some fundamental questions: Is it possible to restore patriotism as a unifying force? Can we create a universal and encompassing version of patriotism? Or have the divisions become too deep to repair? What would a new shared understanding of patriotism look like, and how could it be used to overcome our deeply polarized climate?

To find out more and to get involved in FixUS, go to www.FixUsNow.org or email Michael Murphy at murphy@fixusnow.org

---

**The Unum Test**

**Here’s how it works:** put partisan blinders aside and ask yourself which policies would have the long-term effect of uniting—or further dividing—our country. The policies that pass the test won’t all come from one party or ideology. That’s precisely why it offers an off-ramp from our bitter polarized debates. The Unum Test can reunite our nation because it is rooted in principle and practicality, not partisan agendas, allowing us to make progress towards a more fair, just and prosperous nation. It can help us achieve:

» A political system where solving problems is put ahead of destroying the “other side.”

» An economic system that rebuilds the middle class and ensures equal opportunity and social mobility for all Americans.

» A civic culture that emphasizes shared values and the dignity of every individual, while protecting the open debate that democracy depends upon.

By: John Avlon, Mickey Edwards, Maya MacGuineas, and Jonathan Haidt

Excerpt from TIME Magazine, April 13, 2021
It's no secret that political partisanship and discord have trumped compromise and conciliation in Washington, DC, and among many Americans. A new Ipsos poll sponsored by FixUS confirms that America is a nation at risk. But the results also give reason to hope.

Beneath its ruinous divisions, the foundations of an American nation still stand, with strong agreement on the values, hopes and aspirations that people hold for themselves, their families and their communities.

**Americans are deeply divided**

First, the bad news. Democrats and Republicans might as well be living in different countries when it comes to their opinions about the current state of the nation and the problems most in need of immediate attention. Asked about the economy, 81% of Republicans described it as “strong and growing,” a view shared by only 37% of Democrats.

85% of Republicans believe their nation provides jobs and opportunities for all and 65% believe that the country ensures racial justice. The comparable numbers for Democrats are 35% and 22%. One thing Republicans and Democrats agreed on is that America is divided. Americans ranked “being united” dead last among the attributes that define the state of the country today.

The perception gap over the country’s priorities is just as stark. Thirty-three percent of Democrats’ cited healthcare affordability as the country’s first or second priority, as opposed to 19% of Republicans. Democrats rated climate change as next on their list at 22%, followed closely by improving racial justice at 21%. Neither of these issues got out of single digits for Republicans. Having a strong and growing economy ranked tops for Republicans at 32%, followed by putting America first at 29%. The numbers for those issues for Democrats: 19% and 8%, respectively.

**But there is good news**

So, what's the good news? Beneath the churn of policy divisions, a set of core national values ranked high among all Americans, regardless of party.

Free speech (81%), equal justice under law (80%), and the opportunity to succeed (80%) were ranked extremely or very important across the population. Not all national values fared as well. Republicans and Democrats have drifted far apart on the value of patriotism and faith and religious liberty. While the two values ranked highly with Republicans, a gap of 30% has opened up between the parties on the former and 20% on the latter.

Where unity among Americans shone through was at the personal, family and community levels, where Americans share the same simple goals, regardless of party affiliation, age, gender, race, income or where they live.

Strong majorities rank being healthy (80%), having financial security (74%) and having a loving relationship with a spouse or partner (67%) among their highest goals. Safety is by far at the top of the list of community priorities for Americans. Personal values also reveal a striking degree of unanimity: being honest (90%), hard-working (83%), and independent (80%) were ranked as extremely or very important to Americans as a whole.

What all this tells us is that if America is to heal, it will have to heal from the bottom up. Americans have lost trust in their institutions. The prospect of going back to a more gentle age in Washington doesn’t seem likely, no matter what the result of the coming elections. People who want change are going to have to take matters into their own hands.

Real change will require deep and meaningful citizen engagement. Discussions held around the country by a number of organizations, including our own, have shown that Americans can handle the truth, cope with disagreements and seek common ground even where deep divisions exist.

Every day, Americans work hard together to solve problems. They extend a hand to neighbors in need. And they do so simply because it's the right thing to do. That's why these conversations work, and why they need to continue and to expand across the country.

Within our communities lies the power to engage in open and honest discussion, to listen with an open heart to those with different points of view, and hold America’s leaders to the same standards. While this poll made clear the country's divisions, it also reaffirmed that an American nation lives on in the hopes, values and aspirations of its citizens. It’s time to rediscover that nation.
Healing our divided nation is the defining challenge of our time. Nothing less than the success of the American experiment is at stake.

Our problems won’t be solved with a single election or a new president. Hyper-partisanship has poisoned our politics to such an extent that it compromised our response to the COVID-19 pandemic, fueled the spread of disinformation, and sparked the January 6th attack on the U.S. Capitol.

But the U.S. was fraying long before Donald Trump became president, with growing gaps between the rich and poor as well as deep cultural divides between urban and rural communities. The result is that America often feels like it’s coming apart, with clashing tribes caught in feedback loops of distrust and resentment, amplified online and manipulated through disinformation, driving us toward ever greater levels of mutual incomprehension.

People on different sides of this divide fear that the other side hates their kind. They have a point: a 2019 study found that roughly 42 percent of both parties view the opposition as “downright evil.” In this environment, there is an understandable temptation to fight political fire with fire. But that will only burn the whole house down.

To emerge stronger and wiser from this severe civic stress test, we need to put country over party. We need to address the deeper causes of our divisions while developing a unifying vision that can guide policy debates going forward. We call it the Unum Test. Here’s how it works: put partisan blinders aside and ask yourself which policies would have the long-term effect of uniting—or further dividing—our country. The policies that pass the test won’t all come from one party or ideology. That’s precisely why it offers an off-ramp from our bitter polarized debates. The Unum Test can reunite our nation because it is rooted in principle and practicality, not partisan agendas, allowing us to make progress towards a more fair, just and prosperous nation. It can help us achieve:

A political system where solving problems is put ahead of destroying the “other side.”

An economic system that rebuilds the middle class and ensures equal opportunity and social mobility for all Americans.

A civic culture that emphasizes shared values and the dignity of every individual, while protecting the open debate that democracy depends upon.

What is Unum? It’s an idea that flows from the earliest ideals of our republic. The United States of America was the first nation born out of an idea rather than a tribal identity. Our Constitution begins with a call that transformed subjects into citizens: “We the People.” The founders’ crystalized our mission with a national motto: e pluribus unum, “out of many, one”— and placed it above the eagle holding a cluster of arrows and an olive branch on the Great Seal of the United States.

E Pluribus Unum remains the key to what makes America exceptional in the eyes of the world. America’s role as an imperfect but diverse democratic republic stands in clear contrast to the history of other nations—as well as the ethno-nationalist parties and surveillance state autocracies that are on the rise today. At our best, America remains a rebellious project against tribal and fundamentalist forces. And e pluribus unum is literally the opposite of “us against them”—the demagogues’ eternal calling card.

If we consciously aim to elevate Unum over the divisive forces that encourage groupthink and group-blame it will lead us to durable reforms rooted in broadly shared American values in the intertwined areas of politics, economics, and culture.

Politics

Eighty percent of Americans say they are concerned about political polarization. Seventy-eight percent of Americans believe it’s important that Republicans and Democrats work together. How can we achieve that?

First, by changing the twisted incentive structure in our politics. The rigged system of congressional redistricting can result in parties losing the statewide vote but still winning more seats in Congress. Ronald Reagan called
this the “antidemocratic and un-American practice of gerrymandering.” Today ninety percent of Members of Congress live in “safe seats” without meaningful congressional general elections while about 30% of state legislative races are not even contested. This empowers partisan extremes (especially in closed party primaries) and typically drives down turnout while disincentivizing bipartisan compromise.

Independent non-partisan redistricting commissions, combined with open primaries, would make elections more competitive and representative, driving increased turnout and giving candidates an incentive to reach out beyond their party’s base during campaigns, and especially when they reach congress. Reforms like ranked choice voting – with run-offs – also provide candidates with a powerful disincentive for “going negative” against opponents because they want to win over their opponents’ supporters, which should open the door to more constructive congressional debates. It also may encourage more independent candidates to participate in our politics. It’s worth remembering that the constitution doesn’t mention political parties. Contrary to what many in Washington apparently believe, partisanship is not, in fact, the purpose of our politics.

To restore trust in the fairness of our elections, we need to strengthen voting rights and election security systems with backup paper ballots while combating all forms of voter suppression. We should lower obstacles to voter participation, adopt automatic voter registration for all eligible citizens and expand early voting, including mail-in voting, which has proven effective at increasing participation. Many of these reforms are being considered in congress right now, though the “For the People Act” would go further in many areas.

Finally, growing concerns about political corruption need to be addressed before they fundamentally compromise the credibility of our democracy. It is past time for reforms that reduce the influence of big money on elections, compel legislators to disclose if any of the language in their bills have been drafted by people with a financial interest in its passage, while requiring more transparency about donors to dark money Super-PACs. Presidential candidates should be required to release their tax returns, family members of presidents should not work in the White House and presidential pardons should be processed through proper channels in the Justice Department.

These reforms will not solve all our problems, but if you change the rules you change the game, and you’ll begin to change the culture around our politics. These reforms collectively pass the Unum test because they would reduce the influence of political extremes, increase transparency, and restore trust in the integrity of our elections.

Economy

Even before the unemployment that came from Covid-19, much of the anger in our politics came from the uneven recovery after the last great recession and the destabilizing economic impact of globalization and technological innovation.

Many Americans no longer believe that they’ll get ahead if they work hard and play by the rules. The hollowing out of mid-sized manufacturing cities in America’s Heartland has fueled the rise of populism on the right and left. The middle class has been squeezed for decades with stagnant wages and lower social mobility while at the same time the top tenth of the top 1 percent has seen its share of wealth more than triple. In 1965, the average executive made 20 times the average American worker; today the average CEO makes more than 200 times as much. Executive compensation packages have soared even in the face of scandals, downturns and layoffs.

It’s time to update our economic system and our social contract to better accommodate the changing nature of work. Government needs to return to its critical role of ensuring that fair competition is protected, while companies should focus more on long-term value-creation rather than obsessing over quarterly earnings reports.

One way to achieve this is through a more inclusive vision of capitalism with more opportunities for being a stakeholder in shared success. For example, incentivizing corporations to pass a percentage of profit to its workers can align the interests of management and labor. We need policies to encourage small business start-ups, particularly for those on the lower end of the income spectrum. We should ensure that trade agreements better reflect the interests of American workers, as the renegotiation of NAFTA did. The tax code should incentivize investments in research and development as well as in human capital, which will in turn increase our competitiveness and economic mobility. Finally, critical infrastructure reform can help strengthen our nation while strengthening the middle class for a generation.

All this will have real costs. But we cannot ignore George Washington’s warning about “not ungenerously throwing upon posterity the burden we ourselves ought to bear” in the form of unsustainable debt. While the transnational challenges of the 21st century—including climate change, global health crises, and an aging population—will lead to
a government somewhat larger than we've had in the past, it needs to be financed responsibly with incentives to grow America's economic pie rather than simply redistribute it.

These reforms pass the Unum test because they would "deal everyone in" while reducing some of the frustration and stagnation that drives populist anger. While America should never be punitive towards those who have been successful, the moral legitimacy of capitalism depends on whether a rising tide lifts all boats. There is a special responsibility that falls on the wealthiest citizens to use their money and influence to push for reforms that will make America civically stronger, across partisan lines, in return for all the blessings they have received.

Culture

Trust is eroding across nearly every aspect of our culture. Trust in government, trust in the media and even trust between fellow citizens have all declined dramatically over the past four decades. Democracy withers when people cynically assume the worst about their institutions and each other.

We need to overcome this crisis of confidence before it cripples our country. As the late Congressman John Lewis said, "Maybe our forefathers and foremothers all came to this great land in different ships, but we're all in the same boat now."

In his Farewell Address, George Washington warned that "enlightened opinion" is necessary for a self-governing society. But only about a quarter of students in 2018 scored "proficient" or better on a basic civics test, with about 15 percent scoring the same on American history, according to the National Assessment of Educational Progress. This reflects longtime cuts to civics education from school curriculums across the country.

Investing in civics education again should be an area of bipartisan agreement. An inclusive and honest assessment of American history and civics should be taught beginning in elementary school, while high school students should also be taught an unvarnished account of life in non-democratic societies so that they appreciate what it means to be an American. And here's a bold idea: require all graduating high school students to pass the basic citizenship test that immigrants take when they apply for naturalization.

It is also time to restore a norm of national service, which would rebuild a sense of cultural cohesion and common purpose across class, race and regional lines. This should be more than just military service, including teaching (like AmeriCorps), the Peace Corps, the National Park Service, and work in different local communities, in exchange for an expanded new G.I. Bill that would help young people obtain a college education or vocational training without taking on crippling debt.

We need to expand our commitment to racial justice and equality, ending tolerance for racism in any form. We need to continue to push for criminal justice reform and invest in police retraining to ensure fair and equal treatment for all Americans without sacrificing public safety. This is entirely consistent with the American ideal of judging people as individuals rather than as members of groups—and that is a goal we should always steer towards in matters of policy.

No conversation about healing distrust would be complete without addressing the impact of social media on our democracy. Platforms need to combat disinformation while cracking down on bots and trolls through individual verification. In addition, we need to find ways for news outlets to measure and monetize their success by focusing less on sensational click-bait and more on engagement-based attention metrics; less on profiting off polarization and more on responsible original reporting to foster fact-based debates.

Developing a more cohesive civic culture is essential because our domestic divisions are distracting us from a growing list of external threats, including cyber assaults by Russia on our democracy and our government, the economic rivalry with China, and the cost of extreme weather events that come from the climate crisis. It's no wonder that our adversaries spend so much time and money trying to inflame our identity fault lines. They understand it is America's Achilles heel. Indeed, as other nations grow stronger, they are beginning to challenge America's leadership and America's values. Some of those nations want to impose their values on us. If we don't pull ourselves together, they will succeed.

The good news is that citizens across the political spectrum are now realizing that We the People can no longer take the stability or success of the American experiment for granted. And about 8 in 10 Americans are tired of how divided we have become.

A core theme of Joe Biden's successful presidential campaign was this pledge: "I'm running as a proud Democrat. But I will govern as an American president. I'll work with Democrats and Republicans. I'll work as hard for those who don't support me as those who do." Now as president, he needs to make good on that promise, rather than give into the temptation to "go it alone" with a razor thin margin in congress at a time when there are more self-identified independents in our nation than either Democrats or Republicans.
There is still a strong and vital center in America that is under-represented in our often extreme political debates, a coalition of pragmatic Americans who want our politics to be more constructive. This broad group of politically homeless citizens is a tribe trying to transcend tribalism—and while that may sound quixotic, that is the story of America.

Reuniting our nation will require a new movement to strengthen our democracy. For all our energizing differences, we are all Americans and we need to achieve more unity amid our diversity if our democratic republic is to overcome the global rising tide of ethno-nationalist autocracies. That is a cause worth fighting for.

As Abraham Lincoln wrote in an even more dire time: "The dogmas of the quiet past are inadequate to the stormy present...As our case is new, so we must think anew and act anew. We must disenthrall ourselves, and then we shall save our country."

This task now falls to us. We are divided, but not beyond repair. Guided by the Unum Test, we can move forward together to find common ground and common purpose, armed with the understanding that our independence as a nation is inseparable from our interdependence as a people. We must transcend our tribalism to survive and thrive as the United States of America.